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Welcome to                      , designed to 
sit seamlessly between your audio 
interface and your speakers.
If you can’t trust what you’re hearing, you can’t trust your mix. The truth is your room is 
likely holding you back. Introducing ORIA Mini, the room correction powerhouse that sits 
between your audio interface and speakers - transforming your studio monitoring and 
giving you an instant performance boost. We’ve partnered with Sonarworks to bring 
you a dedicated hardware solution that analyses and corrects your room’s acoustic 
imperfections in minutes, taking your studio from a guess-and-check system to a reliable 
professional monitoring environment. 
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Declaration of Conformities

FCC Part 15B
This apparatus has been tested and found to comply with the limits of a class-A 
digital device, pursuant to Part 15B of the FCC Rules. 

These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 

If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the following measures:

1   Re-orient or relocate the receiving antenna

2   Increase the separation between the equipment and receiver

3   Connect the equipment into an outlet on a different circuit from that to 		
       which the receiver is connected

4   Consult the dealer or an experienced radio/TV technician for help



IEC 62368 Test Report with Japan deviation.

We, Audient, declare that the product, ORIA Mini, to which this declaration 
relates, is in material conformity with the appropriate PSE standards and 
directives for an audio product designed for consumer use. METI Ordinance 
Appendix 12 J55032(H29).

		  We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 
		  01256 381944, declare under our sole responsibility that the product ORIA
		  Mini complies with Part 15 of FCC Rules. 

		  Operation is subject to the following two conditions:

		  1. 	 This device may not cause harmful interference,
		  2. 	 This device must accept any interference received,

			   including interference that may cause undesired operation

We, Audient Ltd, declare that the product, the ORIA Mini, to which this 
declaration relates, is in material conformity with the appropriate CE 
standards and directives for an audio product designed for consumer use.

We, Audient Ltd, declare that the product, the ORIA Mini, to which this 
declaration relates, is in material conformity with the appropriate UKCA 
standards and directives for an audio product designed for consumer use.

Audient Ltd has conformed where applicable, to the European Union’s 
Directive EN 63000:2018 on Restrictions of Hazardous Substances (RoHS) as 
well as the following sections of California law which refer to RoHS, namely 
sections 25214.10, 25214.10.2, and 58012, Health and Safety Code; Section 
42475.2, Public Resources.

Under an environment with electrostatic discharge, the device may cease to 
output sound (EUT could not operate properly). This requires the user reset 
the device by unplugging & re-connecting to host computer. 

The unit may not operate as expected when there is radio interference on 
the power line. The unit will revert to normal operation after user reset.



Installation & Setup



What’s In The Box

1 3

2

1 1 x ORIA Mini Unit

2

3 1 x USB C-C Cable

1 x Sonarworks (™) Measurement Microphone & Mic Clip



Initial Setup 
To begin using ORIA Mini, plug in your input source and speakers and connect ORIA 
Mini to your computer using the included USB cable.

Inputs

You can connect your input source, such as your audio interface or mixer,  via both 
an analogue and digital connection. Connect via the TRS inputs for an analogue 
source and via the Optical port (S/PDIF) for a digital source. You can then select 
which input is currently active in the ORIA Control Desktop Software.

Outputs

ORIA Mini has line-level outputs for connecting a stereo set of speakers and a single 
subwoofer. This is designed to feed directly into a powered studio monitor or a 
power amplifier. 



Mac Installation 

Head over to https://audient.com/products/
monitor-controllers/oria-mini/downloads/ 
to download the latest version of the ORIA 
Control Desktop Software. Once downloaded, 
open the .dmg file and then drag and drop 
the ORIA Control Desktop Software into your 
applications folder.

System Requirements:
macOS 10.13.6 (High Sierra) or Later
Intel CPU or Apple Silicon
1GB RAM Minimum

Windows Installation 

Head to https://audient.com/products/monitor-controllers/oria-mini/downloads/ 
to download the latest version of the ORIA Control Desktop Software. Once 
downloaded, open the .exe file.

Follow the instructions on-screen to complete the installation. This process may take 
a little while, so please be patient. Once complete, click ‘Finish’.

System requirements:
Windows 10 or Later
PC or Laptop manufactured after January 2006
Intel Core 2 @1.6Ghz, or AMD equivalent
1GB RAM Minimum

https://audient.com/products/monitor-controllers/oria-mini/downloads/ 
https://audient.com/products/monitor-controllers/oria-mini/downloads/ 
https://audient.com/products/monitor-controllers/oria-mini/downloads/ 


Registration with Audient ARC 
ORIA Mini comes bundled with a collection of professional software and services, 
giving you everything you need to start recording from some of the industry’s leading
innovators.

Go to arc.audient.com, select ‘Register Your Product’ and enter your details to create
an account. You will then receive a verification email to your inbox but you may
need to check your spam/junk folders. Once you’ve verified your account, register
your ORIA Mini by entering the serial number and the unique 4-digit PIN found on 
the underside of your ORIA Mini.

Now that the product is registered, you can select from a wide array of free software 
and plugins, giving you easy access to powerful creative tools straight away.

http://arc.audient.com


Firmware Update Procedure
Occasionally, Audient will release new firmware for ORIA Mini to add additional 
features and ensure ongoing compatibility with operating system updates.

Provided it has internet access, the ORIA Control Desktop Software will periodically 
check if there are any new firmware updates available and inform you if there are. 

You can also manually check for Firmware Updates by clicking Help > Check for 
Updates

If an update is available, the ORIA Control Desktop Software will notify you. Click 
‘OKAY’ to begin the firmware update process.

The ORIA Control Desktop Software will then launch the Audient Firmware Upgrade 
software. In this software, you will see a list of all Audient devices currently connected 
to your computer. Select ORIA Mini from the device list.



You can now choose to update from audient.com or from a local file. If your computer 
has an internet connection, you would want to select ‘From audient.com’ to ensure 
you are installing the latest firmware version.

If your computer does not have an internet connection, please contact 
support@audient.com and our team will be able to provide you with the latest 
firmware file to install locally.

Now you can click ‘Start Upgrade’ and the progress bar should begin to increment. 
During the update process, the ORIA Mini unit may restart multiple times. 

Once complete, a notification will appear to confirm the update has been installed. 
You can now close the Audient Firmware Upgrade Window and continue using your 
ORIA Mini.

http://support@audient.com


Hardware Features 
and Connectivity



Overview



Analogue Inputs
ORIA Mini includes two balanced TRS inputs designed to take audio signals from an 
audio interface or another line-level source. ORIA Mini can also accept a signal from 
an unbalanced source, such as a CD player or mobile phone

Please note that the maximum input level of ORIA Mini is +18dBu. If your interface has a 
higher maximum output level than this, ensure the volume is sufficiently attenuated to 
ensure the signal is not clipping the inputs of ORIA Mini.

Digital Inputs
In addition to the Analogue TRS inputs, ORIA Mini can also accept stereo audio from a 
digital S/PDIF source. This input uses an optical TOSlink connector.

If you are using a source that outputs an S/PDIF signal via a coaxial connection, then 
you will need to use a coaxial to optical converter, which are readily available online.

Speaker Outputs
ORIA Mini provides three balanced speaker outputs: two for your stereo left and right 
channels and one that feeds a subwoofer. The speaker outputs use a balanced TRS 
connection; however, unbalanced connections can also be made by simply plugging 
in a TS jack instead. 

Please note that the speaker outputs are at line level and are designed to feed active 
monitors. If using passive speakers, then you will need to feed the signal to a suitable 
power amplifier before the speakers.

If using a subwoofer with separate left and right inputs, connect the SUB output of ORIA 
Mini to only the left input of the subwoofer.



USB Connection
ORIA Mini has a USB-C port that is used to both power the device and to provide 
remote control of the device via the ORIA Control Desktop Software. 

Please note that it is NOT possible to send audio to ORIA Mini via the USB Connection, 
audio must be fed in via the Analogue or S/PDIF inputs.

The USB connection requires a USB 3.0 or later port that can provide bus power 
of 5V @ 900mA. Alternatively, ORIA Mini can be powered from an external USB-C 
power supply.

Profile Switching
The Profile Button provides a way to switch between the top four Favourite Profiles 
stored on ORIA Mini, allowing you to quickly adjust your calibration to suit a particular 
setup or based on the media type you are currently working with. 

Simply tap the Profile Button to cycle through the four top saved Profiles. If you have 
fewer than four profiles saved, then it will only cycle through the number of profiles 
stored. 

The profile button can also be used to bypass the DSP and put the unit into standby. 
Press and hold the profile button for 3 seconds to bypass the DSP, the profile LED 
ring will flash when the DSP is bypassed. Press and hold the profile button for 6 
seconds to put ORIA Mini into standby mode. To exit standby or bypass mode, tape 
the profile button once.

Please Note: The Profile button is also used to factory reset the unit. This will reset 
ORIA Mini to its factory state and will remove any stored Profiles

To do a factory reset, hold the button down during power up until the profile LEDs 
flash. Now release the button. Finally, press and hold the button again, at which 
point all LEDS come on and will go out once the unit has finished erasing the flash.



Signal and Peak Indicators
These indicators are used to show the approximate signal level being sent to ORIA Mini. 
The Signal Indicator will show you when a suitable signal level is being sent to the inputs 
of ORIA Mini. 

If you are sending audio to ORIA Mini but the Signal Indicator is not illuminating, this 
may be because you have the incorrect input source currently selected (Analogue or S/
PDIF). Failing this, check that the device feeding ORIA Mini is securely connected. The 
Peak Indicator will illuminate if there is a peak either on the inputs of ORIA Mini, or on 
the outputs. 

If the peak is on the inputs, ensure that the signal from the audio device feeding ORIA 
Mini does not exceed +18dBu. You would therefore need to reduce the output level of 
your audio device. 

If the peak is on the outputs, this may be due to extreme Calibration EQ settings where 
a lot of gain is being added to the signal. In a typical listening space, such drastic 
equalisation shouldn’t be required, and if you find yourself having to apply such 
extreme equalisation to your speaker signals, other solutions, such as different speaker 
placement or better room treatment, should be sought.



Software Features



ORIA Minis speaker calibration and other settings are all controlled by the ORIA Control 
Desktop Software, providing powerful hands-on control of your calibration and audio 
routing. 

Setup ButtonRoomSpeaker Volume
Metering

Speaker Group Controls

Light/Dark Mode

Profiles

Global Bypass

System ButtonSpeakers ButtonInput Source Monitor Controls

Overview



Profiles 
Profiles are the heart of the ORIA Mini control philosophy. When you select a Profile, 
you are selecting calibration parameters for every speaker channel - all in one button 
press.

A total of 32 Profiles can be stored on ORIA Mini itself, with your four favourite profiles 
available from the ORIA Minis Profile Button on the front panel. 

A Profile stores all of the speaker calibration settings, including the EQ curve for every 
channel, trim, delay and crossover. You can either create new Profiles manually in the 
ORIA Control Desktop Software application or by importing them from the SoundID 
Reference app by Sonarworks(™)*.

*A Sonarworks ORIA Mini Add-on License is required to import profiles from Sonarworks 
SoundID Reference.



Creating a New Profile

To create a new Profile, click the ‘+’ icon found in the top right of the Profiles Panel. 
Name your Profile and hit ‘Save’.

Duplicate an Existing Profile

To duplicate an existing Profile, right-click on a Profile name in the Profiles Panel and 
select ‘Duplicate’. A copy of the Profile will appear below the original Profile. 



Rename a Profile

To rename a Profile, right-click on the Profile name in the Profile Panel and select 
‘Rename’. A cursor will appear, enabling you to edit the text. Type the new name and 
press Enter when done.

Delete a Profile

To delete a Profile, right-click on the Profile name in the Profile Panel and select ‘Delete’. 
A window will appear asking you to confirm your deletion.



Selecting a Profile

To use a Profile, you can simply click on it from the Profile list. This is now your active 
Profile. This Profile will be highlighted with white text while the other inactive Profiles will 
be greyed out. 

You can also select the four Favourite Profiles using the Profile Button on the front panel 
of the unit by tapping it to cycle through your designated favourite Profiles.

Profile Organisation

The Profiles list is split into two sections. The ‘Favourite’ Profiles are the four listed above 
the dividing line, each with its own number. These can be selected using the Profile 
Button on the ORIA Mini hardware. The Profiles below the dividing line are the ‘Non-
Favourite’ Profiles. 

Profiles may be reordered at any time, simply by holding down the left mouse button 
on the chosen profile and dragging it to the chosen location. When reordering profiles, 
the following logic applies:

Favourite -> Favourite: The two Profiles will swap locations.

Favourite -> Non-Favourite: The Favourite Profile will be dropped where the user 
intended. The top Non-Favourite Profile is moved up to the Favourite section.

Non-Favourite -> Non-Favourite:  The Profile will drop where the user intended, and all 
Profiles below will shuffle down. 

Non-Favourite -> Favourite: The Non-Favorite Profile will replace the location of the 
original Favourite Profile. The original Favourite Profile will now be placed at the top of 
the Non-Favourite list, and every other profile will shuffle down.



Making Changes to a Profile

If you make any changes to a Profile’s settings whilst it is active a small icon will appear 
next to the Active Profile. This indicates that the changes made have not yet been saved 
to the Profile. 

To save the changes, simply click the icon. Wait a few moments for the changes to be 
saved and a green tick icon will show to indicate this is complete.

If you try to change to another Profile or close the ORIA Control Desktop Software 
without saving the changes, you’ll see a dialogue box window asking if you wish to save 
the changes to the current Active Profile, create a new Profile or discard the changes. 



Importing and Exporting Profiles

The ORIA Control Desktop Software allows you to export your manual Profiles so they 
can be backed up or shared between users. In addition, there is the option to import 
both Sonarworks and ORIA Mini Custom Profiles from an external file.

Exporting a Custom Profile

To export the currently active Custom Profile, go to the menu bar and navigate to File 
> Export Custom Profile. 

You can also export a Profile by right-clicking on it on the Profile List and selecting 
‘Export’.

Importing a Custom Profile

To import a Custom Profile, go to the menu bar and navigate to File > Import Custom 
Profile.

A Finder or File Explorer Window will now open, allowing you to select a previously 
saved Profile. Once you have selected your File, click ‘Open’. 

The next screen allows you to rename the Profile as required. In addition, you can now 
choose whether to create a new Profile or override an existing Profile.

Now, give the Profile a name and select the location that you wish to export your Profile 
file to. Click ‘Save’ and the Profile will be exported. 



Create New Profile - Selecting ‘Create New Profile’ will simply add the Profile to the list 
of Profiles found on the left-hand side of the ORIA Control Desktop Software. Please 
note that you can have a maximum of 32 Profiles, so if you have filled every slot, the 
‘Create New Profile’ will be greyed out and you will have to overwrite an existing setting 
or discard changes. 

Overwrite Existing Profile - Selecting ‘Overwrite Existing Profile’ will allow you to select 
which existing Profile you wish to overwrite.

Select a Profile from the list of Profiles and click ‘OK’. A confirmation screen will appear 
to confirm that you wish to overwrite the selected profile

Please note that once a Profile is overwritten, it cannot be undone. If you wish to return 
to the previous screen, click ‘Back’, or select ‘Cancel’ to abort the import entirely.



Manually Importing a SoundID Profile

To manually import a Sonarworks SoundID Profile, go to the menu bar and navigate to 
File > Import SoundID Profile. 

A Finder or File Explorer Window will now open, allowing you to select a SoundID Profile 
created in the Sonarworks SoundID Reference Software application. 

Once you have selected your File, click ‘Open’. As per importing a Custom profile, you 
can now choose whether to create a new Profile or if you wish to overwrite an existing 
one

You can select from the following input sources

- Line
- S/PDIF

Please note that the Input Source selection is not stored in the Profiles and will need to be 
changed independently when you wish to change the source.

Input Source



Speaker Volume 
You can control the volume level of the speakers by clicking and dragging the Speaker 
volume control.

If using the volume control of an external device to control your monitor volume, Audient 
recommend setting the speaker volume of ORIA Mini to 0dB.

Mute (M) - Mute all speaker outputs.

DIM - Reduce the overall volume by a chosen level. The level of reduction can be 
changed in the System Panel of the ORIA Control Desktop Software.

Mono - Sums the Left and right channels together for mono compatibility checking.

Polarity - Flips the Phase of the Left channel and sums the outputs to MONO.

Monitor Controls
To assist with listening, ORIA Mini includes 4 
monitor controls:



Light/Dark Mode
The ORIA Control Desktop Software can be viewed in Light or Dark mode, depending on 
your preference and your studio environment.

Speakers Button
The Speakers Button allows you to easily return to the 
default Room View if you have the System Panel open. 

Global Bypass
This allows you to bypass all EQ, Channel Trim and 
Delay settings on the ORIA Control Desktop Software. 
Please note, however, this doesn’t bypass the crossover 
controls.

Dark Mode Toggle Light Mode Toggle



PRE
This shows the signals entering the ORIA Mini from your input source. PRE is selected 
as the default.

POST
This shows the signals leaving the ORIA Mini after the output DSP and
going to your speakers. POST Metering mode will take the volume control into account.

SUB
When in PRE metering mode, the Meter for the Sub channel is not shown, as there 
is no SUB signal before the crossovers are applied in ORIA Minis DSP. When in POST 
metering mode the Sub Meter show audio that is being sent to the SUB channel after 
the crossovers.

Metering
The ORIA Control Desktop Software provides a straightforward metering solution to 
allow you to quickly check your levels, output routing and the impact of ORIA Minis DSP. 
Meter settings are entirely independent of your Profiles, so they will not change when 
moving between Profiles.



Expanded Meter Panel

The Metering Panel can be expanded to its own window by clicking the expand icon, 
allowing you to keep your meters in the foreground whilst mixing. The Expanded 
Metering Window shows more details such as a dBFS scale and peak values. 

Setup Button
The Setup Button allows you to manually edit the calibration settings for each individual 
output. Click on a Speaker Icon in the Room Section to see a range of options for that 
speakers output.

A halo will appear around that speaker to indicate it is currently being edited.

Please Note: when importing a profile from Sonarworks SoundID Reference, EQ 
controls for the Profile are locked and cannot be changed. If you wish to make 
changes to the EQ curve, this should be done in SoundID Reference and then re-
imported.



Speaker Setup

Shows the name of the channel currently being adjusted.

Mute (M) - You can Mute the individual speaker selected. You can Mute a channel by 
pressing the ‘M’ key on your keyboard whilst in Setup Mode.

Solo (S) - You can Solo the individual speaker selected. You can Solo a channel by 
pressing the ‘S’ key on your keyboard whilst in Setup Mode. 

Copy/Paste - If you wish to use the same settings on other speakers, then you can click 
the Copy Button. You can then select another channel and click the Paste Button to 
apply the copied settings to that channel. 

You can also paste the DSP settings to a Speaker Group if you wish to use the same 
settings for all speakers in that group.

Simply ‘Right Click’ on a Speaker Group within the Groups Panel and click Paste to copy. 

Please note that only the EQ and Crossover DSP settings will be pasted to groups. Trim 
and Delay values should always be set on a per-speaker basis to ensure correct time 
alignment of your speaker setup.

Reset - The Reset Button sets the channel back to its default settings. A Dialogue Box 
will appear to confirm you wish to reset the settings to ensure settings are not reset by 
accident.



EQ

When creating a manual profile, by default, 8 EQ points (6 parametric bands, a low 
shelf and a high shelf) will be available per channel to adjust the calibration of that 
speaker output. However, it is possible to remove bands to make for a clearer graph, so 
you are not using all 8 EQ points.

EQ bands are added using the + and - icons in the Channel setup window. Pressing 
the + button will add a new EQ point at 1kHz on the graph. You can then enter your 
frequency, Q and ±dB values for the new band, or manually drag the EQ point on the 
graph. Pressing the - button will remove the currently selected EQ point on the graph. 

The left and right band arrows allow you to navigate through the EQ bands shown on 
the graph to choose which is the currently selected EQ band. 

You can also use the left and right arrow keys on your keyboard to navigate between 
bands. Undo and Redo Buttons are provided should you make a mistake with your 
settings. 

The Bypass EQ Button allows you to disable the EQ on this particular channel.

Please Note: Sonarworks profiles have 18 EQ bands available and offer a higher 
resolution calibration.



Output Controls

In this section, you can control various options for each individual output. At the bottom of 
the Setup Panel, there are three further controls for speaker calibration. 

Trim - The first control is Trim, which raises or lowers the level of this speaker by up to 12dB, 
in increments of 0.1dB. Click and drag this control to either add or remove Trim from this 
speaker. Alternatively, double-click on the control to input a numeric value manually.

Delay - The second control is Delay, which delays the signal from this speaker by the 
defined amount of time. This is useful in time aligning speaker signals to arrive at the 
listener from each speaker at the same time for optimal imaging. The Delay control has a 
range from 0 milliseconds to 75 milliseconds, in increments of 0.01 millisecond. 

Click and drag this control to add Delay to this speaker signal, alternatively double click 
the control to manually enter a numeric value. The Delay control also has a separate ‘On’ 
button to toggle the delay on and off.

Crossover - The third control is Crossover, and this is for configuring Bass Management. 
When engaged by clicking the ‘On/Off’ button, Bass Management is now enabled for this 
speaker.

This means that audio frequencies that had been sent to this speaker channel below the 
defined frequency value seen in the control will be removed from this signal path, and 
instead redirected to the subwoofer channel. 

Crossover Controls are not shown for the SUB channel since they are not required for the 
SUB channel.



Profile Setup

The Profile Setup tab contains settings that apply to the entire profile, not just to one 
particular speaker channel. 

Speaker Profile Trim - The Speaker Profile Trim allows you to specify a volume trim for 
the active Profile in order to match the levels of your various Profiles and avoid loud 
volume jumps when moving between Profiles. An adjustment of ±12dB can be made.



Room
This section provides a visual display of your speaker configuration. The white USER 
icon indicates the direction that the listener would face. The colours of the units 
indicate which of the speaker Groups they belong to:

	 • FRONTS = Dark Purple
	 • SUBS = Green

When a speaker is receiving audio, you will see a small waveform icon appear on it. 
This is helpful when trying to identify which speaker output is playing audio during 
setup and installation.



Solo and Mute
Speakers in the Room may be Solo’d or Muted using the following keyboard shortcuts:

	 • Mute - Left Click

When a speaker is muted, or not active because other speakers are Solo’d, the speaker 
icon will be greyed out. Whilst a speaker is Solo’d, the Mute function will become 
unavailable for all other speakers and groups but users will be able to continue to Solo 
other speakers in the Room. 

Solo’d speakers will have their corresponding meters active in the ‘Post’ metering 
window. 

Clearing Solo/Mute states is possible by using the following shortcut: 

	 • Option (MacOS) / Alt (Windows) + Left Click
 
Clicking on a Solo’d speaker will clear all active Solos, and if clicked on a Muted Speaker 
it will clear all active Mutes.

	 • Solo - Shift + Left Click



Speaker Group Controls
This monitoring function allows you to Mute or Solo the Stereo speakers and the Sub 
Speakers separately. When individual speakers, or Speaker Groups, are muted, they will be 
greyed out in the Room Window.

Similarly, if a Speaker Group or Groups have been Solo’d, then all other Groups will be 
greyed out in the Room Window.



System Panel
The System Panel button at the top of the ORIA Control Desktop Software lets you look under 
the hood at the more advanced settings for connectivity and control. The System Panel is 
split into two different pages, which are selectable using the tabs on the left-hand side.

General

DIM Trim
Here you adjust how much the level is reduced by when the DIM function is enabled.

Crossover Attenuation
This control allows you to apply a global attenuation to any signals being sent to the 
Sub channel via the crossovers. 

An attenuation between 0dB and -10dB can be applied.

Global Delay
This applies a time delay to all output signals on the ORIA Mini, which allows for audio 
to be easily synced with a video file. 



Setup
When a device, such as an iPad running the ORIA Control iPad App, tries to connect to 
ORIA Mini, you are given the option to either Accept, Deny, or Block the device.

The remote page allows you to control what devices have remote control over ORIA 
Mini. 

More information regarding remote control via the ORIA Control iPad App and 
Streamdeck integrations can be found in the Remotes section of this manual.

Remotes



Forgetting Approved Devices 
If you wish to remove a device from the Approved Devices list, click the ‘i’ icon next to 
the device. A pop-up notification will ask you to confirm that you’d like to ‘forget’ this 
device.

Unblocking Blocked Devices 
Similarly, if you wish to remove a device from the Blocked Devices list, click the ‘i’ icon 
next to the device. A pop-up notification will ask you to confirm that you’d like to unblock 
this device. 

Once unblocked, this device is again able to make connection requests.

If you accept the request, the device will be added to the Approved Devices list found 
in the Remote page of the System Panel. Any device that is approved will automatically 
connect to ORIA Mini when used on the same network. A green tick icon is shown next 
to the device when a device is connected to ORIA Mini.

Otherwise, if the request is blocked, the device will not be connected to ORIA Mini and 
will also be blocked from making further connection requests. This is useful if you are in 
a facility that has multiple ORIA Mini units or an educational facility where you wish to 
restrict remote access except for approved devices.

When a device is blocked, it is added to the Blocked Device list so you can easily see 
which devices have been blocked.



In order to correctly calibrate your monitors for your listening environment, it is 
important to take high-quality measurements of your space. The included Sonarworks 
Measurement microphone allows you to do this. 

Please note: ORIA Mini does not have a microphone input. It is therefore advised to 
use the microphone input on the audio interface that is feeding ORIA Mini. If your 
audio interface does not have a microphone input, then you will need to find a way of 
connecting your microphone in order to take measurements. 

Output Calibration

Sonarworks SoundID Reference 

Our close integration with Sonarworks allows you to easily import calibration profiles 
onto ORIA Minis onboard DSP, allowing you to apply speaker calibration without the 
strain of CPU usage on your computer.

Sonarworks Licenses

In order to use SoundID Reference with ORIA Mini, you require both a valid SoundID  
Reference License and the Sonarworks ORIA Mini Add-on Bundle. 

ORIA Mini can be purchased both with and without SoundID Reference License. If 
ORIA Mini was purchased without SoundID Reference, it can be purchased from your 
local dealer or directly from the Sonarworks Website.

The ORIA Mini Add-on License Bundle provides the ability to import calibrations to 
ONE ORIA Mini unit. When a calibration is initially loaded onto ORIA Mini from SoundID 
Reference, the serial number of the unit is captured, and that is then associated with 
your Sonarworks account. 

If you wish to import Calibrations to multiple ORIA Mini units, such as in a multi-studio 
facility, then you would need to purchase a separate ORIA Mini Add-on License for 
each unit.

https://store.sonarworks.com/


Measurement Process

The Sonarworks measurement process is very straightforward, and you are walked 
through each step to ensure an accurate measurement. 

If using a subwoofer, before carrying out a measurement in SoundID Reference, it’s 
important to set your crossover frequencies in the ORIA Control Desktop Software. This 
ensures the stereo measurement in SoundID Reference is accurate. 

To set your crossover frequency, select either the left or right speaker in the Room 
section of the ORIA Control Desktop Software and click the Setup button. The crossover 
frequency can then be adjusted using the control in the bottom right of the Setup panel.

The crossover frequency used would depend on the frequency response characteristics 
of both your speakers and subwoofer. If you are unsure of what crossover frequency to 
use, contact your speaker/subwoofer manufacturer for further advice.  

If the crossover is adjusted after the measurement, this will affect your calibration, and 
you will need to re-measure. We’d therefore recommend ensuring the crossover is set 
correctly before carrying out your first measurement. 

You can find a full walkthrough of the process here.

https://www.youtube.com/watch?v=2xaTES3gnTI&ab_channel=SoundIDfromSonarworks


Importing Calibrations to ORIA Mini

After a measurement has been made, the results can be imported into SoundID 
Reference. Here you can create calibration profiles which can be uploaded to the ORIA 
Mini hardware.

In the SoundID Reference Software, click Export Preset to Device and then select ORIA 
Mini from the device list.

Firstly, you can make adjustments to your calibration curves before exporting them. Here 
you can add EQ curves to match the content you are working on, such as the Dolby Film 
Curve, Dolby Music Curve or similar. You can also make your own custom adjustments. 

If the ORIA Mini is currently connected to your PC, then you can directly transfer the 
Calibration to ORIA Mini; otherwise, you can export a Parameter file, which you can later 
import to ORIA Mini via the ORIA Control Desktop Software.

Please Note: The first transfer to ORIA Mini must be done directly with the ORIA Mini Device Connected. 
This is so the serial number of ORIA Mini can be read and associated with your Sonarworks account. 
Any subsequent exports can either be done directly or as a parameter file.



The new Profile will now appear in the Profile Panel. Please note Profiles created with 
SoundID Reference will be denoted by a Sonarworks ‘S’ appearing next to the Profile 
name.

Direct Import

If you select Direct Transfer to ORIA Mini, the ORIA Control Desktop Software will be 
brought into focus and you’ll be asked if you wish to create a new Profile or overwrite 
an existing Profile.

If you create a new Profile, you’ll be prompted to give it a name. If you choose to 
overwrite an existing Profile, you’ll be given an option of which Profiles are available 
to overwrite.



Import via Parameter File

If you export a parameter file, you can easily import this onto ORIA Mini by opening 
the ORIA Control Desktop Software, going to the menu and clicking ‘File > Import 
SoundID Profile’.

A Finder or File Explorer window will open, allowing you to select the file. And then as 
per a direct transfer, you can choose whether to create a new Profile or overwrite an 
existing Profile.

Please Note: When using SoundID Profiles in ORIA Mini, the SoundID Reference 
Software should be closed or disabled. Otherwise, the audio may be processed 
twice, resulting in inaccurate calibration.



ORIA Mini Add-on License Required 

Customers who already own SoundID Reference are able to purchase a separate ‘Add-on 
digital license key’ from Sonarworks, enabling the user to export calibration Profiles directly 
to ORIA Minis hardware. 

If you attempt to export a profile from SoundID Reference to ORIA Mini without a valid 
ORIA Mini Add-on License (digital key) then you will be prompted to purchase one before 
continuing the export.

Can’t Read Serial Number  

In order to export a Profile to ORIA Mini, SoundID Reference will need to read the serial 
number from your ORIA Mini. If the serial number cannot be read then an error message 
will appear. 

Please note: ORIA Mini Add-on License (digital key)  is included in both the ORIA Mini + 
SoundID Reference Complete Bundle and the ORIA Mini + SoundID Reference Add-On 
Bundle. If you believe you already have a license then please contact the Sonarworks 
support team.

Sonarworks SoundID Reference 
Troubleshooting



Cannot Export 2.1 Profiles 

Please note that if using SoundID Reference for Multichannel, it is not possible to export 
2.1 measurements to ORIA Mini. Crossover settings and Sub calibration should be handled 
manually.

To resolve this, please check that ORIA Minis USB cable is securely connected to the 
computer and click Retry. If the issue persists, please try a different USB port or USB cable. 

If the issue still remains, please contact the Audient support team.



If you prefer not to use SoundID Reference, then third-party measurement software can be 
used instead. The included Sonarworks Measurement Microphone can be used for this, or 
you can use your own reference mic if preferred. 

If using third-party software, it is not possible to directly import your settings into ORIA Mini, 
the speaker calibration settings must be entered manually. The third-party software should 
give you an EQ curve you can apply to each channel, as well as Trim and Delay settings. 

These settings can then be entered manually for each channel as explained in the Setup 
Menu section earlier in this manual. When manually calibrating, you can adjust the 
following for each speaker channel: 

	 • EQ (up to 8 bands, 6x ±12dB, 20Hz - 20kHz + Hi-shelf and Lo-shelf) 
	 • Output Trim (±6dB) 
	 • Delay Time (0-75ms)
	 • Crossover Point (30Hz - 500Hz)

Manual Calibration



Controllers



ORIA Remote iPad App
Never miss a beat with ORIA Minis iPad App. The power of touch grants you remote 
access to all of ORIA Minis control features from one centralised control hub. Adjust 
levels, audition speakers, switch profiles and monitor your metering - all directly 
from your desktop. Precise control without the complexity.

Avaliable to download for free on the Apple App Store

https://apps.apple.com/us/app/oria-remote/id6498923078
https://apps.apple.com/us/app/oria-remote/id6498923078


Initial Setup

With ORIA Mini connected to your computer via USB and the ORIA Desktop Software 
running, you are ready to connect to the ORIA Remote iPad App for complete touch 
control of ORIA Mini. Firstly open the Apple App Store, search for ORIA Remote and 
install it onto your device.

Upon opening the app, you’ll be shown a short guide to familiarise you with the 
functions of the application. 

As part of this, you’ll be asked to name the iPad. This is what it will appear as in the 
ORIA Control Desktop Software. You will also need to allow the ORIA Remote iPad App 
to find and connect to devices on your local network.

Please note that the ORIA Remote iPad App will still connect to your ORIA Mini 
host computer even if it is connected via ethernet instead of Wi-Fi. This is provided 
that all devices are still connected via the same network.



You will then need to allow this connection on the ORIA Control Desktop Software as 
per the instructions found in the “Remotes” section of this manual. Once the connection 
has been approved, you should then see a “Successfully Connected” message. You 
can now begin using the ORIA Remote iPad App to control your ORIA Mini. 



Application Overview
Once connected, the ORIA Remote iPad App has a number of pages which you can 
switch between to control various aspects of ORIA Minis hardware. You can switch 
between these pages using the icons on the left-hand Sidebar Menu. Below, you can 
see a brief overview of each of these pages:

The Home Page is the main page of the ORIA Remote iPad App and gives you an 
overview of all the main controls of ORIA Mini. A quick overview of these functions can 
be found on the following page.

Home -

Profile Selection

Monitoring Section

Output MeteringGroup Mute and Solos



Profile Selection

Here you can select from the various profiles that you have created in the ORIA Control 
Desktop Software. Simply tap a Profile to make it your currently ‘Active Profile’. 

Group Mute and Solo

These controls let you mute the Stereo or Sub channels, or solo the Stereo channel.

Output Metering

The meters show the current signal level on the outputs of ORIA Mini. You can also 
expand the meters by pressing the expand icon next to the title to view the meters with 
more resolution. 

Monitoring

The Monitoring section has three main controls: Input Source, the Main Volume Control 
and the Monitor Controls.

Input source
Here you can adjust the input from which the ORIA Mini takes its audio from; either the 
Line or S/PDIF inputs.

Main Volume Control
This controls the overall output level of ORIA Mini to the speakers.
To stop the volume from being accidentally adjusted, this control is locked by default. It 
can be unlocked by tapping the control, which allows you to adjust the level. 

Once you tap anywhere else on the screen, the volume control will be automatically 
locked again. This auto-locking behaviour can be toggled on and off in the settings 
menu. 

Monitor Controls 
Here, you can use the global monitor controls available on ORIA Mini. These controls 
are Mute, Mono, Dim and Phase. More information about these controls can be found 
in the ORIA Control Desktop Software monitoring section of this manual. 



Profile Selection

This section is a repeat of the Profile Selection section found in the Home Page.

Group Mute and Solo

Similarly, this section is a repeat of the Group Mute and Solos section found in the 
Home Page.

The Room Page gives you per-speaker control of your setup with a visual representation 
of your speaker setup.

Profile Selection

Group Mute and Solos

Room Section

Room -



Room

This section allows you to easily mute and solo the individual speaker outputs of ORIA 
Mini.

Simply, tap one of the speaker icons to mute that output, and then tap it again to 
unmute it. To solo a speaker output, long-press one of the speaker Icons and tap it to 
un-solo it. 

When you have channels solo’d or muted, a “Clear All Solo” or “Clear all Mute” button 
will appear. Tapping this will undo any solos or mutes and return you to all-channel 
playback. 



The Monitor Page displays an expanded view of the Monitor section found in the Home 
Page. Please see the Home Page section above for an overview of these controls  

Monitoring -

Global Controls

Profile Selection Main Volume Control

Group Mute and Solos



Pre/Post Control

‘PRE’ is selected as the default, and shows the signals entering the ORIA Control Desktop 
Software from your DAW outputs. ‘POST’ shows the signals leaving the ORIA Mini after 
speaker calibration processing. ‘POST’ metering mode will also take the volume control 
into account.

The metering page provides high-resolution monitoring of all output levels on ORIA 
Mini. 

Metering -

Meters

Pre/Post Control



The Profile Selection Page is simply an expanded version of the Profile Selection section 
found on other tabs, allowing you to select which one of your Profiles is currently active 
as well as any other Profiles you have outside of the Profiles assigned to the four 
favourite slots. 

Profile Selection -



The Connection Page is used should you need to re-connect the ORIA Remote iPad 
App to the ORIA Mini or wish to change the currently connected device. 

Connection -



App Colour Mode

Here you can set the ORIA Remote iPad App to display in either Dark mode or Light 
mode to best suit your studio environment. 

You can also set this to System Default so the ORIA Remote iPad App will automatically 
adjust to the global iPad settings. This is useful if your iPad is set up to automatically 
adjust between light and dark mode based on the time of day. 

iPad Name

This changes what the iPad is shown as when connecting to the ORIA Control Desktop 
Software

Volume Control Autolock

App Colour Mode

Settings -



Volume Control Autolock

This control changes how the locking behaviour of the Main Volume control functions. 

With Autolock enabled, tapping anywhere outside of the volume slider will automatically 
re-lock the volume level setting after it has been adjusted. 

With Autolock disabled, the volume control will remain unlocked after a volume 
adjustment until the volume control is tapped again to lock it. 



Stream Deck
ORIA Minis Stream Deck integration allows you to control a majority of ORIA Minis 
functions remotely using any device from the Stream Deck family. This means you 
can keep ORIA Mini installed on your desktop, but still have complete control over 
your monitoring whilst remaining in the sweet spot of your speakers. 

Avaliable to download for free on the Elgato Marketplace

https://marketplace.elgato.com/product/oria-control-0d6d36b4-83d7-49a9-bc17-eaa6ee65b1e4
https://marketplace.elgato.com/product/oria-control-0d6d36b4-83d7-49a9-bc17-eaa6ee65b1e4


Installation 

Provided that you are using ORIA Control Desktop Software V1.3 or later, the ORIA 
Control Stream Deck Plugin is included in the ORIA Software installer. If the ORIA Control 
Desktop software detects the Elgato Stream Deck software installed on your system it 
will prompt you to install the ORIA Control Plug-in.

Otherwise, the ORIA Control plug-in can be found on the Elgato Stream Deck 
Marketplace. To install, simply ensure you are logged into your Elgato Account, click 
‘Get’ and the ORIA Control Plug-in will be added to the Elgato Stream Deck Software 
control panel. 

Profiles

To allow for a quick setup, the ORIA Control Plug-in includes Profiles for all of the 
common Stream Deck Devices. This automatically loads all the required controls onto 
your Stream Deck device so you can immediately begin using your Stream Deck with 
ORIA Mini.

You can, of course, create your own custom profiles if preferred, and this is explained 
further in the ‘Actions’ section below. 

Important Note:
Due to how the Stream Deck software works, when the ORIA Control Plug-in is 
installed, only the Profile for the Stream device currently open will be installed. If 
you wish to use multiple Stream Deck devices, then you can easily download the 
required Profiles from the Elgato Marketplace: https://marketplace.elgato.com/
stream-deck/profiles

Profiles are available for the following Streamdeck Devices:

•	 Stream Deck MKII
•	 Stream Deck +
•	 Stream Deck XL
•	 Stream Deck Mini
•	 Stream Deck Neo
•	 Stream Deck Mobile 



Volume allows you to adjust the output volume of ORIA Mini. On Stream Decks without 
Dial controls you will typically have two volume buttons, one to increment upwards and 
another to decrement downwards. The button can either be pressed once to increment/
decrement the volume, or pressed and held to make larger volume adjustments 

On Stream Deck +, the Volume action can also be assigned to one of the 4 dials. The 
dial will simply operate as a standard rotary volume control, however, it is also possible 
to press the Dial down to mute/unmute the Outputs of ORIA Mini. 

Controls:

Volume -

Actions

Output - Sets which output the Volume Action is adjusting.

Step - Adjusts if the button increases the volume or decreases it. (This option is not 
available when used with a Dial on Stream Deck +.)

If you wish to create your own custom Profile containing ORIA Mini controls, then you 
can do so using the various ORIA Control Actions included in the ORIA Control Plug-in. 
Below is a brief description of each action and how they can be used:



Output -  Sets which output the Mute Action is affecting.

Output - Sets which output the Dim Action is adjusting. 

Mute disables/enables the Output on ORIA Mini.

Controls:

The DIM action reduces the ORIA Mini output by a predetermined amount, perfect for 
quickly talking to an artist without needing to pause or mute playback. 

Controls:

Mute -

Dim -



Action - This control provides two options; “Step Through” or “Set To”. “Step Through” 
lets you cycle through the various input options. “Set To” lets you specify which input 
source should be selected when this button is pressed. 

Step - When “Step Through” is selected as the Action, this lets you choose whether the 
control steps forward or backward through the input sources. 

Source - When “Set To” is selected as the Action, this allows you to set which source is 
selected when this button is pressed. 

Input Source allows you to select which of the various input sources (Line or S/PDIF) is 
currently being used by ORIA Mini.

Controls:

Input Source  -

Mono will sum the stereo output of ORIA Mini to a single Mono signal, allowing you to 
check the mono compatibility of your mix.

There are no additional controls for the Mono action.

Mono -

Polarity will inverse the phase of the left stereo channel and then sum the left and right 
channels together. This cancels out anything panned centrally and allows you to hear 
the ‘Sides’ portion of your mix.

There are no additional controls for the Polarity action.

Polarity -



Profile - Here you can select which Profile is assigned to this button from the 4 
favourite profiles.

Speakers - Here you can select which speaker output is being controlled by this button.
 
Action - Either Cut or Solo can be selected as the speaker action.

The Profile button allows you to select which Profile is currently active on ORIA Mini. 
Please note that only the top 4 ‘Favourite’ Profiles are available in the ORIA Control 
Stream Deck plug-in. When a Profile is active the button will display a blue gradient. 

Controls:

The Group action allows you to either Solo or Mute a specific speaker output (L, R, or 
SUB) on ORIA Mini.

Controls:

Profile -

Speaker -



Group - Here you can select which Speaker Group is being controlled by this button.
 
Action - Either Cut or Solo can be selected as the Group action.

The Group action allows you to either Solo or Mute the two Speaker Groups, Stereo and 
Subs on ORIA Mini.

Controls:

Group -



Troubleshooting
Yellow Warning Appears on Action When Pressed

If a warning sign appears on the button when pressed, this indicates that Stream 
Deck cannot communicate with the ORIA Control Application. 

Firstly, check that the ORIA Control Desktop Software is open. If it isn’t, open it from 
your Applications folder or Start Menu. If the ORIA Control Desktop Software is open, 
please quit the application and re-open it so that the Stream Deck Control software 
can re-establish its communication with ORIA Mini.

The Profile for my Stream Deck Device was not installed. 

The Stream Deck Control software will only install the Profile for the Stream Deck 
device that is connected and in focus at the time of installation. For example, if you 
have a Stream Deck + connected and open in the Stream Deck Control app, then 
when you install the ORIA Control Plug-in, it will only install the Stream Deck + Profile 
for ORIA Control

If you change your Stream Deck or wish to use multiple Stream Deck devices, then 
you can install other ORIA Control Profiles for all Stream Deck Models, directly from 
the Elgato Marketplace: https://marketplace.elgato.com/stream-deck/profiles

https://marketplace.elgato.com/stream-deck/profiles


Technical Specifications
System Specs:
	 • Analogue Input Channels: 2
	 • Analogue Output Channels: 3
	 • Digital Input Channels*: 2
	 • System Sample Rate: 96kHz 
	    (with inbuilt sample rate conversion for digital inputs)

	 *No audio streams over USB. USB is for power and control data only.

Line Output (via Optical Input):
	 • Max Output Level: +18dBu
	 • Dynamic Range (A Weighted): 127dB
	 • THD+N (-1dBFS): -113dB/0.0002%
	 • Frequency Response (20Hz > FS/2*): ± 0.1dB
	 • Crosstalk (1kHz): <-123dB 

	 *FS/2 of the incoming optical signal.

Line Input to Line Output:
	 • Max Input Level: +18dBu
	 • Dynamic Range (A Weighted): 122.5dB
	 • THD+N (-1dBFS): -105dB/0.0005%
	 • Frequency Response (20Hz - 40kHz): ± 0.2dB
	 • Crosstalk (1kHz): <-118dB

Digital Input:
	 • Stereo S/PDIF: 44.1kHz to 96kHz

USB:
	 • Connector Type: USB-C
	 • Bus Power Requirement: 0.9A @ 5V >=USB 3.0 Port
	 • Included Cable: USB-C - 1m



Sonarworks Measurement 
Microphone Technical 
Specifications 

Microphone Type: Electret-condenser

Transducer Type: MEMS

Frequency Response: 20Hz - 20kHz

Polar Pattern: Omni-directional

Output Impedance: 330Ω

Sensitivity: -40dBV/Pa

SNR: 65dBA

Dynamic Range: 105dB

Max SPL: 125dBSPL

Power Requirements: +48V Phantom Power

Connector Type: 3 Pin XLR

Weight: 54g



Tel: 0044 1256 381944

IMPORTANT SAFETY INSTRUCTIONS

• Read instructions - All the safety and operating instructions should be read
before the product is operated.

• Retain instructions - The safety and operating instructions should be retained
for future reference.

• Heed Warnings - All warnings on the product and in the operating instructions
should be adhered to.

• Follow Instructions - All operating and use instructions should be followed.

• Cleaning - Unplug this product from the wall outlet before cleaning. Do not 
use liquid cleaners or aerosol cleaners. Use a dry cloth for cleaning.

• Attachments - Do not use attachments not recommended by the product
manufacturer as they may cause hazards.

• Water and Moisture - Do not use this product near water-for example, near 
a bath tub, wash bowl, kitchen sink, or laundry tub; in a wet basement; or 
near a swimming pool; and the like.

• Accessories - Do not place this product on an unstable cart, stand, tripod,
bracket, or table. The product may fall, causing serious injury to a child or 
adult and serious damage to the product. Any mounting of the product 
should follow the manufacturer’s instructions, and should use a mounting 
accessory recommended by the manufacturer.

• Flame Sources - No naked flame sources, such as lighted candles, should 
be placed on the product.

Safety Information



Warranty Information

Warranty Statement 

Your ORIA Mini comes with a manufacturer’s warranty for three years (36 months) 
from the date of despatch to the end user. The warranty covers faults due to defective 
materials used in manufacture and faulty workmanship only. During the warranty 
period Audient will repair or at its discretion replace the faulty unit provided it is returned 
carriage paid to an authorised Audient service centre.

We will not provide warranty repair if in our opinion the fault has resulted from 
unauthorised modification, misuse, negligence or accident. We accept liability to repair 
or replace your ORIA Mini as described above. We do not accept any additional liability. 
This warranty does not affect any legal rights you may have against the person who 
supplied this product - it is additional to those rights. 

Warranty Limitations 

This warranty does not cover damage resulting from accident or misuse. The warranty 
is void unless repairs are carried out by an authorised service centre. The warranty is 
void if the unit has been modified other than at the manufacturer’s instructions. 

The warranty does not cover components which have a limited life, and which are 
expected to be periodically replaced for optimal performance. We do not warrant that 
the unit shall operate in any other way than as described in this manual.




